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Chapter One

Introduction to Visual Basic

Objective

Course objective — This course focuses on Windows programming using visual Basic to create graphical user
interfaces. The course examines forms, controls, graphical controls, loops, control arrays, database and
traditional file processing, and OOP.

Be able to demonstrate knowledge of interface design principles and be able to apply them in
a visual programming environment.

Have a working knowledge of object oriented concepts and how to implement them in a visual
programming environment.

Be able to apply database linkages.

Create a windows application in a visual programming environment.

Create an Internet (web) application in a visual programming environment.

VB supports programming projects that run in both:

Microsoft Windows and,
Web (Internet) environments.

Commercial GUI Desigh/Development Approach

Modern programs run in a Graphical User Interface (GUI) environment. You can open up any
desktop program or web browser and examine the GUI. This interface includes:

Buttons (some with Icons and Graphical Images) and Menus on which you point and click.
TextBox controls in which you type information.

Graphical images to guide a system user in using the program.

Other components.

A GUI for a version of Microsoft Word is shown in this figure.
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commercial programming standards.
e Program design and coding is satisfactory.

e Work is equivalent to that expected from someone already working in the information technoloc
programmer.

e Grade you according to commercial standards.

VB supports programming projects that run in both Microsoft Windows and Internet environments.
Windows operating system(s).

Microsoft Visual Studio and Visual Basic (.NET Version)

Programming Languages

Microsoft's Visual Studio (also called Visual Studio.NET) includes several different programming
languages:

e Visual Basic,

e Visual C# (C sharp),

e Visual C++ (cee-plus-plus),

e Visual F# (F sharp),

e JScript and

e Web Development (called ASP.NET).

e [t alsoincludes the .NET 4 Framework upon which these languages operate.

All of these languages compile.

e This means they are translated from human readable-form to machine readable-form to the
same Microsoft Intermediate Language (MSIL).

e MSIL run within the Common Language Runtime (CLR) — a component of the .NET
Framework.

Visual Basic (also termed Visual Basic.NET or VB) is a major revision of earlier Microsoft VB products.

e This version is Version 10 of VB.

e This is an upgrade of earlier.NET versions.

e The current and earlier versions are not completely compatible—a program coded with an
earlier version that is upgraded to the current version cannot be opened again with the earlier
version software.

e Version 6 and earlier are not .NET-compatible — programs created with these versions are
completely incompatible with .NET applications.
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VB is available in several editions including the free Express Edition that you can download from
Microsoft. Other editions (Professional, Premium, and Ultimate) are used within industry.

e Our classroom has the Visual Basic 2010 Express Edition installed.

Visual Studio Components

When Visual Studio is installed on a computer, there are two mandatory components to the
installation and an optional third component.

e .NET Framework Class Library. This is a library of predefined class objects. It enables you to
quickly build a computer application through the use of predefined objects such as forms, text
boxes, labels, buttons, drop-down list controls, and others (mandatory).

e Common Language Runtime (CLR). This component manages the execution of a programming
project written in any of the languages that are included within Visual Studio including Visual
Basic as a language (mandatory). This component is installed as part of the .NET Framework.

e MSDN (Help). This is the help component and provides access to a help reference library. It
is an optional, but highly recommended component.

Object-Oriented Programming Terminology

VB is an object-oriented programming language.
e Means you work with objects in building an application.
e Examples: Form objects, Button objects, TextBox objects, Label objects, ListBox objects,

PictureBox objects, and more.

VB is also termed an event-driven programming language because you will write program code that
responds to events that are controlled by the system user. Example events include:

e C(licking a button or menu.

e Opening or Closing a form.

e Moving the mouse over the top of an object such as a text box.
e Moving from one text box to another.

In order to work with VB, you need to understand "object" terminology as defined in Table 1.

Name

Events <:| Hees |:> Properties

Object

J

Methods
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Table 1

Terminology

Definition

Object

A thing — like a noun in English. Examples include forms and controls you place on
forms such as buttons, text boxes, and icons.

Property

Objects have properties — like adjectives in English. Properties describe object
behaviors. Examples of properties include Text, Name, BackColor, Font, and Size.
Refer to a property by the notation ObjectName.PropertyName (use the .dot
notation) — example: TotalDueTextBox.Text or AccountLabel.ForeColor.

Method

Like a verb in English — these are the actions that objects exhibit. Examplesinclude
methods to Show and Hide forms and methods to Print and Close forms.

Refer to a method with the notation ObjectName.MethodName —
example Me.Close will close the current form.

Event

Events are actions usually triggered by the system user such as clicking a button;
however, events can also be triggered by the actions of objects. For example,
closing a form can trigger an event.

Class

This is a really abstract term — it is a sort of template for an object. For example,
all forms belong to the Form class of object. All buttons belong to the Button class
of object. Classes include definitions for object properties, methods, and
associated events. Each class is assigned an identifying namespace within the .NET
Framework Class Library.

Each new object you create is defined based on its class — the new object is called
a class instance.

Getting Started with Visual Studio

You will use the VB component of Visual Studio to create and test projects.

e The programming applications you will design and develop are called solutions in VB.

e A solution can actually contain more than one project, but in this course we will focus on just
creating a single project in a solution.

e Each solution is stored in a folder identified by the solution name.

e This is covered in more detail later in this set of notes.

Launching Visual Basic

Start VB — Click the Windows Start button and locate Microsoft Visual Studio 2010 — launch the
program by clicking. The option will look something like this.
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Control Panel

The first screen to display may require you to choose your Default Environment Settings.

e [f this screen displays, click the Visual Basic Development Settings option in the list box and

then click the Start Visual Studio button

Choose Default Environment Settings

O Visual Studio 2010 Utimate

development activity.

settings selected below,

Choose your default environment settings:

General Development Settings
Project Management Settings
Visual C# Development Settings

‘ Visual C++ Development Settings
Visual F# Development Settings

Web Development
Web Development (Code Cnly)

Before you begin using the application for the first time, you need to specify the type of development
activity you engage in the most, such as Visual Basic or Visual C#. This information is used to apply a
predefined collection of settings to the development environment that is designed for your

il You can choose to use a different collection of settings at any time. From the Tools menu, choose
Import and Export Settings and then choose Reset all settings.

‘ [V] Migrate my eligible settings from a previous version and apply them in addition to the default

Description:

Optimizes the environment so you can focus on
building world-class applications. This collection of
settings contains customizations to the window
layout, command menus and keybeard shortcuts to
make common Visual Basic commands more

accessible.

Start Visual Studio ] [ Exit Visual Studio




Visual Programming 15202

The Visual Studio Start Page is shown in the figure below. The start page is slightly different for
Visual Studio 2010 (Professional or Ultimate Edition) and Visual Basic 2010 Express Edition.

e This is the Start Page for Visual Basic 2010 Express Edition.

File £ View Debeg Troh Windew Heip
Lalhid J-wdidl s MR =2l e r A3y DFnE J],

Mat Page x

¥ Clote page sher progect load
¥ Show page on stamtup

Click the New Project link shown in the figure above to create a new project. This opens the New
Project dialog box shown below.
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e Your first project will be a Visual Basic Project using a Windows Forms Application template
as shown in the figures above.

e The default name is WindowsApplicationl -- not a very useful name. Change the project
name to: Ch01VBUniversity.

e C(lick the OK button — it takes several seconds to create the project files from the template.

The Integrated Development Environment

Familiarize yourself with the Integrated Development Environment (IDE).

e Across the top are menus with different options used in the designing of an application.
e Toolbars with shortcut icons are shown below the menus.
e Form Designer (also termed the Document Window).

o Displays open documents such as the Form1 shown in the figure below.

o Tabs along the top are used to allow you to switch rapidly between open documents.

o Every project starts with a default form named Form1 — the form you modify to build your
business application.

o The form can be resized by using the sizing handles.

o The form can be renamed (you’ll do this later in an exercise).

e Solution Explorer Window — displays filenames for files that comprise a project. The solution
name is also shown here (ChO1VBUniversity).
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e Properties Window — displays properties of the currently selected object — in the figure the
properties displayed are those of the Form object.
e ToolBox Window — this is shown along the left edge of the figure in collapsed display.

Menus used in designing the form.

Architecture Test Analyze p

e S d-d@l bAlAl=29 -0 1 a@ESQFHERE DO -
Forml.vb [Design] X ~ Solution Explorer

3 N ey ._},'J
ﬂ - alaAE=T S

a3 Forml ] %] ChO1VBUniversity

=4 My Project

5] Forml.vb

s92nos eje il X000 X.

Default form
named Form1l

ESEIHTY I Team Explo...
- Q%

Solution Explorer Properties
and Properties Form1 System.Windows.Forms.Fo ~

Windows i 2| | @ A
ShowInTaskb: True

Size 300, 300
SizeGripStyle Auto
StartPosition WindowsDefaul
Tag

Text Forml

Text
The text associated with the control.

The Toolbox
The Toolbox:

e Contains controls that are used to build forms.

e Can be expanded or collapsed with the Pin/Unpin icon.

e Parts of the Toolbox can be expanded/collapsed with the white and black pointer icons to the
left of the groupings.

e Used to add controls (tools) to a form by either double-clicking or dragging/dropping (your
option on which to use).
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Resetting the Default IDE Layout

Sometimes you startup VB and the IDE layout is not what you expect.

e Windows you want such as Solution Explorer, Toolbox, or Properties may be closed.
e The quick way to reset the layout is through the Window menu, Reset Window
Layout submenu option as shown in this figure.

Analyze  Window | Help
B Oy | N 4

Float

Auto Hide All

__:‘ Close All Documents

Reset Window Layout ‘
v 1 Forml.vh [Design)

Windows., |

Building the Ch01VBUniversitv-AppIicatioh -- Project Specifications

Setup the Project and Form

There are several actions you need to take for every project.
e Change the form's FileName property.
o Click the FileName in the Solution Explorer window — change the FileName property

in the Properties window.

o A FileName should always end in the .vb file name extension.
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Changing the form's FileName also changes the Name property of the form — select

the Form and examine the Name property (the easiest way to select the form is to single-

click the title bar).

Solution Explorer
(o [ e | e |
L9 ChOo1VBUniversity

W My Project

7] Studentinfo.vis

3 Solution Ex.., M Tearmn Explo...

Properties

Enter a new name for the
File Name property -
remember to include the .vb
file name extension or the
file can become unusable.

Studentinfo.vb File Properties
el 2 4
Build Action Compile
Copy te Outp Do not copy
Custarm Tool
Custom Tool

Studentinfo.vb

File Name
MName of the file or folder,

form.

o Select the Form.

o Click the Alphabetic icon shown in the figure below to list the properties

alphabetically.

Change the Title Bar value of a form by typing a new value into the Text property for the

o Type the new value VB University — Student Information in the Text property of the

Properties window.
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E =4 My Project

@ 5] StudentInfo.vb

A

=

Q

o

=3

|2

' \-“3] Solution Explorer | 5 SEETANSILI
Properties > 0 X

StudentInfo System.Windows.Forms.Form -

l 5 5 B =
\ StartPosition WindowsDefaultLocation -

’ E 3 Tag

Chan'glng the value typed into the ...- VB University - Student Information

form's Text property changes the |—"""" e bt

value displayed in the form's title TransparencyKey [_]

bar. UseWaitCursor False
} WindowState Normal

Text

The text associated with the control.

e Size the form as needed by clicking the white squares around the form and dragging/dropping.

e Settheform's StartPosition property to CenterScreen. This will cause the project when it runs
to display in the center of the computer monitor screen.

e Setthe form's Font property — usually you'll leave this at about an 8.25 point font, but in class
| use a 10 point bold font so everyone in the back of the room can see the overhead display.

Naming Rules and Conventions

Now you are ready to build a form — you will be placing controls on a form and you need to know
the naming rules and conventions that you will follow this term in naming controls.

Visual Basic automatically assigns a value to the Name property of each control, for
example, Labell, Label2, Label3, or TextBox1, TextBox2, TextBox3,
or Button1,Button2, Button3. However, it is difficult to remember the difference between Labell
and Label2 so:

e if you are going to later refer to the controls, it is best to rename them to a more meaningful
name,

e if you are not going to refer to the controls later, then just use the assigned default name such
as Labell.

When you name an object such as a Label or TextBox or Button, you must follow these rules:

|ll

underscore” character.

&

e An object name can begin with an alphabetic letter or the specia
e An object name can include letters, digits, and underscores.
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e An object name CANNOT include a space or a punctuation mark.
e An object name CANNOT be a VB reserved word such as Button, Close, or TextBox.

® An object name can contain a VB reserved word - object names such
as PrintButton, CloseButton, NameTextBox, and MajorTextBox are legal names.

Several naming conventions exist within industry —the common ones are the Hungarian naming
convention and the Pascal naming Convention.

Naming conventions are simply guidelines to help other programmers read your code more
easily. We will use the Pascal naming convention. The rules are:

e Begin an object name with an uppercase alphabetic character.

e C(Capitalize each word that is part of an object name.

e Select object names that are meaningful.

e Append the full name of the control class to the end of the name.

e Avoid abbreviations unless they are standard abbreviations such as SSN (social security
number).

e Examples of valid names: MajorTextBox, ResetButton, MessageLabel, TotalDueTextBox,
and CloseButton.

This table gives examples naming conventions.

Hungarian Naming Conventions
Form Frm FrmMain, FrmStudent, FrmTeachers
TextBox Txt txtName, txtMajor
Button Btn btnShipping, btnExit, btnReset
Label Lbl IbIName, IblOutput
Listbox Lst LstName
Image Img ImgBox
Option Button | Opt OptSelect
Note: Label controls are often not renamed — they are not referred to later in writing computer
code so the default assigned name is unchanged.
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Build a Form Like This One

VB University - Student Information

|~ Student name: Douglas Bock
B - Academic major: :Computer hManagement & Information Systems
Display Display Display
Student #1 Student #2 Student #3
Reset : ;
Form Print Form ’ ‘ Exit
R - >
\ W _
Two label controls that Six Button controls Two TextBox
display message prompts that perform controls set to
informing the application different actions read-only to
user what data will display. when clicked. display output.

1. Open the Toolbox — select the Common Controls node.

2. Place a Label control on the form by either double-clicking the Label tool or by drag/dropping
a label to the form.

o Notice that when you select the Toolbox's label control, the mouse pointer on the
form becomes a crosshair showing you where the upper left corner of the label will
be displayed.

o Dragthe new label to where you want it in the upper left corner of the form.

o Change the label's Text property to Student Name:

o The label also has a Name property — the first label is named Labell. This is a
satisfactory name and you will not refer to the label when you later write
programming code so leave it named Labell.

3. Add a second label control on the form. Set the Text property to Academic Major: — this
label is named Label2.

4. Add two text box controls as shown.
o Name the first text box control NameTextBox.
o Name the second text box control MajorTextBox.
o These TextBox controls will only display output so set the
properties ReadOnly = True and TabStop = False.

5. Add six button controls as shown.
o Name the button
controls DisplaylButton, Display2Button, Display3Button, ResetButton, PrintButto
n, and ExitButton.
o Set the Text property of the buttons to display the text shown in the figure above. Use
the ampersand (&) symbol as part of the text in order to create button hot keys (hot
keys work just like clicking a button when you press the Alt key + the hot key

simultaneously).

o Examples:
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e For the ResetButton type the following: &Reset
e For the PrintButton type: &Print
e For the ExitButton type: E&xit

For DisplaylButton type: Display Student #&1

If you accidentally place a control on a form and discover that you don't need the control, simply

delete it.

Resize each control to an appropriate size.

Saving and Running a Project

To save a project, use the File-Save All menu —AVOID using File Save As menu options —
Repeat, DO NOT USE File Save As menu options. You can click the Save All button shown in the

figure below.
e This will save all files in the project.
e You can specify the location for saving the project. For a location select either:

o My Documents folder
o The Temp folder on drive C: (C:\Temp).

Studentinfo.vb [Design]* X

IS

1 =5 VB University - Student [nformation\ Click the Save All o |[&=
button to save the
Student Name: project.

A . i B

~ Solution Explorer

(%] Ch01VBUniversity
=4 My Project
5] Studentinfo.vb

Save Project

Name: Ch01VBUniversity

Location: C:\Users\Doug\Documents\CMIS142\VB University Projects

Solution Name: Ch01VEPniversity ¥! Create directory for solution

| Add to source control

solution name if necessary.

Check the Create directory for solution
checkbox.

There are several ways to run a project to test it.

Use the Debug menu, Start Debugging option, or

ms.F
| Save | [ cancel J
L Use either My Documents or /
drive C:\Temp location to T
save your project. Entera Tk VB University - Student

TopMost False

TranspareD

UseWaitC False
WindowS Normal

Towt
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e Press the F5 function key to run the project, or
e Click the shortcut green arrow on the shortcut toolbar.

il Edit View Project Build | Debug 5 Data Format Tools Window

e R =

I > 3 Start Debugaing F l
b -~ I I Start Without Debugging ChrlFS
Al Windows¥orms | uk  Attach to Process,,
L BAIRer =

Run a project by selecting the Debug menu.
Start Debugging option. or click the FS
function key, or click the green arrow
shortcut icon on the toolbar.

Click SAVE ALL Button to
save all work on a project.

ey | Windows »

Run the project. Confirm that the project starts up centered on the console, and the alignment of
controls is professional in appearance.

Name and Text Properties

As you have seen already, forms, labels, text boxes, and buttons have numerous properties. We
will focus on learning just a few of these in this chapter.

= Name property — used to name a control for your reference. For example, we will name the
buttons with a name such as DisplayButton or ExitButton.

o Notice that the name begins with a word that describes the control — often you will
use the text on a control such as a button as part of the control’s name.

o Next the type of control such as Button or TextBox is added to the name to create a
unique name.

o Text boxes may be named NameTextBox and MajorTextBox, or some other
meaningful name.

o If you're not going to reference a control in the project, you can just use the default
name assigned by VB.

= Text property — used to display text values on a control.

o The Text property for a form displays the words that are displayed in the form's Title
Bar.

o The Text property of a button displays the words on the button, such
as Display or Exit. Using the ampersand causes a letter on a button to be
underlined.

o The Text property for a text box control displays the actual words typed into the text
box.

Locking Controls

After you finish sizing control on a form, you can lock the controls to prevent accidental movement

of the controls. :
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e Right-click any control and select the Lock Controls option in the context menu that displays
as shown in the figure below.
e Right-click again and select Lock Controls to unlock the controls.

You'll notice a small "padlock" icon on the upper left corner of the locked controls.

vl VB University - Student Information e | ) 2

Studaent Namea:

cadoemic Major:

Display

Display Display
Studont 1

Student 2 Studant 33

‘ Reanat ‘ ‘ Proint ’ ‘ Exit ‘ |
3] View Code F7

o Lock Contrals

Lock symbol. Right-click the form and / —
T Properties

select Lock Controls —

Program Coding

Programming or writing program code is the means used to cause something to happen when an
event, such as a button click occurs. There are six events to be coded for this project —the first three
events are for the three display buttons.

e Click event for the button named DisplaylButton, Display2Button, and Display3Button.
e Click event for the button named ResetButton.

e Click event for the button named PrintButton.

e Click event for the button named ExitButton.

You need to master the following coding statements and concepts in this section:

e How to access an event procedure.

e The Remark statement.

e Switching between the View Designer and View Code windows.
e Accessing Intellisense.

e The Assignment statement.

e The Clear method.

e The Me keyword and the Close method.

Accessing an Event Procedure

Double-click the DisplaylButton control.

e This opens the coding window shown in the figure below.
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o The window is called the View Code window.

o You can also access the code view from the View menu or the View icon in the
Solution Explorer window.

o The programmer has typed remarks above the Public Class statement — remarks begin
with a single quote mark and display in green print —remarks are for humans to read
—the computer ignores remarks.

B R | L B L T T T T e L = e B T PN T ) e ]

SALIGITAU G StudentInfo.vb [Design]®

i1 (General) - | ) (Declarations)
= 'Project: ChelvBUniversity
'D. Bock hh\_ -
, ; Remarks in the General
Today's date 5 B
'Illustrates displaying information to read-only Declarations section.
textbox controls by clicking buttons.

wolalld L

Public Class statement defines an
- instance of the Form class.

= Private Sub DisplaylButteon _Click(ByVal sender As System.0Object, ByVal e As System.EventArgs
Handles DisplaylButteon.Click

End Sub \ Empty sub procedure ready to be

End Class coded - note the Handles clause.

=IPublic Class StudentInfc

o
~—

m

Double-clicking the DisplaylButton control causes VB to generate an event sub procedure
named DisplaylButton_Click to handle the Click event of the DisplaylButton control.

e The Handles clause indicates that this sub procedure handles the Click event of the button
named DisplaylButton.

e The sub procedure ends with the line of code End Sub.

e Each sub procedure must have a unique name — VB generates a name by combining the name
of the control + an underscore + the name of the event, e.g., DisplaylButton_Click.

e Each sub procedure has two parameters inside of the parentheses that accompany the event
name — these are named sender and e. For now you can ignore these parameters. Later in
the course we will learn to refer to them whenever we need to in order to write more complex
code.

The form named Studentinfo is created as an instance of the general Form object defined in the
.NET Framework class library.

e |tis declared by the Public Class Studentinfo statement.
e The End Class statement marks the end of the form's class definition.

The Remark Statement

A Remark statement is a line of code shown in green.
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e Remark statements are non-executable.

e A Remark is only read by human beings — VB ignores remarks when running a
project. The Remark statement is used to document your program code.

e Remarks are very useful for large programs. They can be used to embed comments that only
programmers will read into programs for later reference.

e Each sub procedure should contain remarks that identify the purpose of the sub procedure.

e A Remark can also be placed in-line at the end of a line of programming code.

e Remarks are entered in the general declarations area of the program by placing the mouse
cursor just before the Public Class statement, then pressing the Enterkey several times to
make room to type remarks.

e Here are some example Remark statements.

'Project: ChO1VBUniversity

'D. Bock

'Today's date

'lllustrates displaying information to read-only
' textbox controls by clicking buttons.

Switching Between the View Designer and View Code Windows

Often you will need to switch between the View Designer and View Code windows. The different
ways to do this are shown in the figure below.

e Click one of the tabs to display either the View Designer or View Code windows.

e Click the View Code icon in the Solution Explorer to open the coding window.

e C(lick the View Designer icon in the Solution Explorer to display the form for additional design
layout.

e C(lick the View menu and select either the Code or Designer submenu options.

Accessing Intellisense

VB's Intellisense feature makes it easier for you to type programming statements.

To access Intellisense simply begin to type the name of an object such as the NameTextBox control
shown in this figure — VB will pop up a window that displays possible selections — this makes it
easier for you to type code and leads to fewer typing errors.
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= "Project: Ch@lvBUniversity
'D. Beck
'Today's date
'Illustrates displaying information to read-only
textbox controls by clicking buttons.

FPublic Class StudentInfe

= Private Sub DisplaylButton_Click(ByVal sender As System.Object, ByVal e As System.Eventirg:
Handles DisplaylButton.Click
'Display informaticn for first student
Na
- Eiid “% MyBase -
End Clas .
: “44 MyClass
“4¢ MyGroupCollectionAttribute
1 Name Public Property Name As String
% NameTextBox —| Gets or sets the name of the control.
{} Net
“% NetPipeStyleUriParser
“% NetTcpStyleUriParser

|6 MmseeChofal LD arear
| Common | All |
e———

e With the Intellisense focus on the NameTextBox, just type a dot (period) and the Intellisense

will next display all of the properties of the NameTextBox — type the letters "Te" (see the

figure below) and Intellisense will search and find the Text property and set the focus to that

property for this text box control.

landles DisplaylButton.Click
'Display information for first student
NameTextBox. tel

End Sub v AppendText

d Class -
ce il A SelectedText
= Text Public Overrides Property Text As String
S TextAlign Gets or sets the current text in the System.W
_‘f TextLength

| Common | All

= Now type an equal sign (=) followed by your name inside double-quotes, e.g., "Ahmed Ali".
= The statement you've typed should look like this inside the sub procedure — VB will provide

the necessary spacing automatically.
= This is called an Assignment Statement and is discussed in detail in the next section.

Private Sub DisplaylButton_Click (ByVal sender As System.Object, ByVal

e As System.EventArgs) Handles DisplaylButton.Click
'Display information for the first student
NameTextBox.Text = "Ahmed Ali"

End Sub
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The Assighment Statement

The Assignment Statement is used to assign values to a property of an object such as a control.

= The general form of the assignment statement is shown here.
= The value on the right side of the equal sign is assigned to the property of the object on the
left side of the equal sign.

Object.Property = Value

Assign a student name to the Text property of the TextBox control named NameTextBox and a
student’s major to the TextBox control named MajorTextBox. The assignment statements to do
this are:

Private Sub DisplaylButton_Click (ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles DisplaylButton.Click
'Display information for the first student
NameTextBox.Text = "Ahmed Ali"
MajorTextBox.Text = "Computer Science & Information Systems"
End Sub

Notice that the value is enclosed within double-quote marks.

e This indicates the value is a string of characters and only string data is stored to
the Text property of a TextBox control.
e The value is displayed in brown text.

The Clear Method

The Clear method is used to clear the contents of a TextBox control. The general way to execute a
method is shown here:

Object.Method ()

Return to the design view and double-click the Reset Form button control — this will generate
a Click event sub procedure for this button. Type a remark and two statements to clear the contents
of the two TextBox controls as shown here.

Private Sub ResetButton Click(ByVal sender As System.Object, ByVal e
As System.EventArgs) Handles ResetButton.Click
'Reset the form by clearing the TextBox controls
NameTextBox.Clear ()
MajorTextBox.Clear ()
End Sub

The Close Method

The Close method is used to close a form. To close a form use the keyword Me to refer to the
form.

Return to the design view and double-click the Exit button control — this will generate a Click event
sub procedure for this button. Type a remark and a statement to close the form as shown here.
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Private Sub ExitButton Click(ByVal sender As System.Object, ByVal e A
s System.EventArgs) Handles ExitButton.Click
'Exit the application by closing it
Me.Close()
End Sub

Printing a Form

Visual Basic includes a PrintForm component — this is not a visible control on the form when added
to a form —instead it displays in the component tray of the project.

e Return to the form’s Design View (the Toolbox does not display in code view).

e As shown in this figure, locate the PrintForm component in the Visual Basic
PowerPacks section of the Toolbox.

e Double-click the PrintForm component — you will see it display in the component tray of the
IDE below the form you are designing. It will be named PrintForm1.

Toolbox
= All Windows Forms ~

> Common Controls
> Containers
> Menus & Teoolbars
> Data
- Components
4 Printing
R Pocinter
£ PageSetupDialog
_,g PrintDialcg

L2 PrintDocument =
% PrintPreviewControl
:E PrintPreviewDialeg

4 Dialogs

'S Pointer
[%] ColorDialeg
| FelderBrowserDialog
45 FontDialog
&~| OpenFileDialog
%] SaveFileDizalog
> WPF Intercperability
>~ Reporting

4 Visual Basic PowerPacks
R Pointer

E PrintFor
5 LineSha[ Pointer ‘

The printing PrintAction options when printing a form are: (1) Print to Printer, (2) Print to File, and
(3) Print to Preview — this third option saves paper so we will use it.

Double-click the Print Form button control and then enter remarks and two coding statements as
shown here.

Private Sub PrintButton Click(ByVal sender As System.Object, ByVal e
As System.EventArgs) Handles PrintButton.Click
'Print the form to a print preview window
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'Assign a PrintAction option
PrintForml.PrintAction = Printing.PrintAction.PrintToPreview

'Print the form

PrintForml.Print ()
End Sub

Finish Coding the Application

To finish the application you need to write code for two buttons named Display2Button and
Display3Button. The code for these buttons is shown here. Notice that these buttons are coded
like DisplaylButton, however, different student and major information is displayed.

Private Sub Display2Button Click (ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles Display2Button.Click
'Display information for the second student

NameTextBox.Text = "Jalal Hassan"
MajorTextBox.Text = "Computer Science "
End Sub

Private Sub Display3Button_Click (ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles Display3Button.Click
'Display information for the third student

NameTextBox.Text = "Hussain Mohammed"
MajorTextBox.Text = "Information Systems"
End Sub

Save the program and execute it to test it.

If you have not done so already, add Remark statements before the Public Class statement. These
remarks identify the project, you as the programmer, and the date the program was written and
must ALWAYS be included in the project.

e Place the mouse cursor in front of the Public Class statement.
e C(lick the Enter key several times to add blank lines above the Public Class statement.
e Type additional remarks similar to those shown here.

'Ch01VBUniversity

'Ali M.

'Today's Date

'TIllustrates displaying information to read-only TextBox
'controls by clicking Button controls

Managing Projects

Copying Your Project to a Flash Drive

You need to be able to save your project and copy your work to a backup device, such as a flash
drive.

e VB will save your project files every time you build or execute a project after your initial save.

{2
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e VB projects consist of many different files and folders within folders.

e Save files as you work by clicking the Save All button on the button toolbar. DO NOT
USE the File-Save As menu at any time to try to save the project — if you do, you will likely only
save an individual file, not the entire project, and you will not have a complete project saved.

To save a VB project and copy it to a flash drive:

e Click the Save All button.

e Exit VB by clicking the File menu, Exit menu option. If you have not saved all of your program
modifications, VB will ask you if you wish to save your changes. It is important to exit VB
prior to trying to backup your project.

e Once you have exited VB, use the Microsoft Windows My Computer to navigate to drive
where your project is stored on either My Documents or C:\Temp folder. You should be able
to locate a folder named Ch01VBUniversity — this is the solution folder for the project you
developed while studying these notes.

e To make a backup to a flash drive. Copy the entire folder from its current location to your
flash drive,

e This figure shows the project folder opened up.

[ ——
qu! » Libraries » Documents » CMISI42 » VB University Projects » ChO1VBUniversity » v | 43 Il Search ChotVBUniversit
Organize v Share with v Burn New folder oE
T Favorites Documents library SO
B Desktop Ch01VBUniversity i
& Downloads T ;
i ChOLVBUniversity [ co

=1\ Recent Places £k ‘
3 File folder w

4 Libraries
-+ Documents
J Music
k=| Pictures

E Videos
*@ Homegroup

1% Computer
& He ()
—a FACTORY IMAGE (D:)

e You may wish to examine the project folder. This figure above shows the folder open. Notice
that the original project folder named Ch01VBUniversity has another folder inside of it with
an identical name. It also has the Ch01VBUniversity.sIn solution file.

e If you click the "inner" Ch01VBUniversity folder, you will find folders named bin, My Project,
and obj. You will also find at five files with names
like ChO1VBUniversity.vbproj, Ch01VBUniversity.vbproject.user, Studentinfo.designer.vb, S
tudentinfo.resx, and Studentinfo.vb as shown in the figure below.
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e You should confirm that the backup copy of the project folder on your flash drive contains
folders and files that are identical to the folders and files in your original project folder.

Documents library

ChO1VEBUniversity

Arrange

3

bin My Project
! File folder File foldei
? === Ch01VBUniversi
obj (S8 VB vicial Racic :'t?’ fila
‘ File folder =T 1| e s
=B Ch01VBUniversity.vbproj Vg Studentinfo.Designer.vb
‘—5 Visual Studio Project User Oy — | Visual Basic Source file
|—c— StudentInfo Vg Studentinfo.vb

source file

isual Basic

| =
. :&l NET Managed Resources File

= G OS KB

(]

Opening an Existing Project

Now you've returned from lunch and are ready to resume work on your project.

e Use the Windows Start button, then find Microsoft Visual Studio.Net!

e Locate the ChO1VBUniversity project listed under existing projects.

e Click on Ch01VBUniversity.sIn to launch the project —this will enable you to revise or continue
work on an existing project.

Program Errors

From time to time you will make errors when entering program code. VB expects you to follow
specific rules for syntax, punctuation, and spelling.

VB has a smart editor that attempts to find and fix most errors.

e If VB cannot understand some of your code, it will display a blue squiggly line under the part
of the line; that cannot be interpreted.

e In the figure below the blue squiggly line indicates that VB does not understand what
the textName or textMajor objects are.

e Most likely, you named these two objects NameTextBox and MajorTextBox when designing
the form, but then used the wrong name when typing code in the sub procedure.
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& Private Sub btnDisplay Click(ByVal sender is System.Object, ByVal e Ais

'System.EventArgs) Handles btnDisplay.Click
'Display name and major to the two textbox controls

Ne.textName . Text = "Douglas Bock”
i Me.textMajor.Text = "Computer Management and Information Systems"
End Sub

The blue squiggly line indicates some sort of error -- here the
name of each of the text box controls is misspelled -- does not
match the name specified during form design.

Typical syntax errors include:

e Referring to an object such as a label or button control by the wrong name — either you forgot
to name the control or you made a mistake when typing the name.
e Forgetting to use the syntax: object.property.

o Forgetting the dot between the object and property names will cause an error.
o Typing an incorrect or invalid property name will also cause an error.

VB lists errors in the View menu -> Error List window that opens when you run your VB
project. The figure shown below displays an error message corresponding to the error that occurs
when you don't type the name of a control correctly.

Studentinfo.vb™ X BEULEGILRGR Pl )

/¥ Display2Button -| 7 Click -
'‘Display information for first student =%
NameTextBox.Text = “"Douglas Bock” -
MajorTextBox.Text = “"Computer Management & Information Systems”

End Sub
= Private Sub Display2Button_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) E

Handles Display2Button.Click
‘Display information for the second student
NameTextBox.Text = "Jill Unverzagt"
MajorTexBox.Text = "Computer Management & Information Systems

End Sub

s System.Object, ByVal e As System.EventArgs)

Private Sub Display3Button_Click(Byval se
Handles Display3Button.Click
‘Display information for the third student = &
NameTextBox.Text = "John Meisel” A typing error. The error list
MaiorTextRox.Text = "Franamics" window. i

100% « ¢

@ 1Eror | 1\ 0Warnings | (i) 0 Messages
Description File Line Column Project

@1 'MajorTexBox' is not declared. It may be inaccessible duetoits Studentinfo.vb 19 9 Ch01VBUniversity
protection level.

There are two other types of errors that we will study in later chapters:

e Run-Time error —an error or exception that occurs while running a program.
e Logic error —a program error that causes the display of erroneous output.
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A Clean Compile

After you correct errors in your code, access the Build menu and select the Rebuild option to
recompile the program into a new MSIL version.

Compiling means to convert the program from human-readable form to machine-readable form —
all referenced classes and components are combined by VB into an executable (.exe) file.

Design Time, Run Time, Break Time

There are some additional terms for you to learn about designing and executing a VB program.

Design Time — when you are designing a project using the IDE, you are in what is
termed Design Time.

Run Time — when you execute or run a project, you are in Run Time.

Break Time — occurs whenever VB encounters some type of processing error that prevents

program execution from continuing. We will cover error-handling throughout your studies of
VB.

VB Help

MSDN

The Microsoft Developer Network (MSDN) library contains books and technical articles to help you
answer questions that will arise as you learn the VB language. This must be installed on your
computer in order for it to be available from the Help menu within VB.

MSDN can be access from a hard drive, network drive, or the Web (requires an Internet
connection).

e Hard drive installation is fastest and most convenient.

e Web access is from http://msdn.microsoft.com.

This figure shows the Help menu.

Window | Help

o =P Gh @ View Help Ctrl+F1
- Manage Help Settings Ctri+ Alt+F1
MSDN Forums

Report a Bug

S @

Samples
Customer Feedback Opticons...
Register Product
Check for Updates
% Technical Support
Online Privacy Statement...

About Microsoft Visual Studic

You may opt to view Help on the Internet or use local Help installed on the PC.
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B Vous! Studio 2010 - Windows Internet Explorer = T

1/0 g e/ 12100147672 e mednstanbigrotisct=VSa v | 13 | 4
Fle Edit View Fwvortes Took Help
- o0 Cweme S @R @-O- @00 soee
X # v :'i- = §» Choose Gare * | PIeass Choose your favonta game from the aropdomn on hs ke »
i Favontes 5|+ WY Facebook | Teme B [T Microsoft Expresz 0. | ¥ Visual Studic 2010 -8B - o~ Pagev Ssfetyv Tockv @~
Visual Studio 2010 OO Visual Studio
ibeary Honse ;

Visual Studio 2010 Send Feedback
Vigual Studic )
isual Shudio Application Lifecycie Management

NET Frarnewnrk 4 This dooument provides rescurces for leaming how to use Visual Studio to create desktop applications and

Web applications,

Retated Linka

Nind2 and COM Development [Windows
Mo

“t Help System Documentatior w Welcome to Visual Studic 2010

Leam about Visual Studio 2010

I l Documentation

You can also obtain context-sensitive help on an object by placing the insertion point in a word in
the coding editor or by selecting a VB object and pressing the F1function key.

A good way to start learning about Help is to access the Help menu Index option, then inside that
window, access the Help menu and look for Help on Help as a submenu — this explains how to look
up topics in Help.

You're now ready to complete your first computer programming laboratory assignment. You may
wish to review these notes prior to starting your practice computer lab assignment.

Solution to In-Class Exercise

'Ch01VBUniversity

'D. Bock

'Today's Date

'Tllustrates displaying information to read-only TextBox
'controls by clicking Button controls

Public Class StudentInfo
Private Sub DisplaylButton Click(ByVal sender As System.Object,

ByVal e As System.EventArgs) Handles DisplaylButton.Click
'Display information for the first student

NameTextBox.Text = "Douglas Bock"
MajorTextBox.Text = "Computer Management & Information
Systems"
End Sub

&
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Private Sub Display2Button Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Display2Button.Click
'Display information for the second student

NameTextBox.Text = "Jill Unverzagt"
MajorTextBox.Text = "Computer Management & Information
Systems"
End Sub

Private Sub Display3Button Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Display3Button.Click
'Display information for the third student

NameTextBox.Text = "John Meisel"
MajorTextBox.Text = "Economics"
End Sub

Private Sub ResetButton Click(ByVal sender As System.Object, By
Val e As System.EventArgs) Handles ResetButton.Click
'Reset the form by clearing the TextBox controls
NameTextBox.Clear ()
MajorTextBox.Clear ()
End Sub

Private Sub PrintButton Click(ByVal sender As System.Object, By
Val e As System.EventArgs) Handles PrintButton.Click
'"Print the form to a print preview window
'Assign a PrintAction option
PrintForml.PrintAction =
Printing.PrintAction.PrintToPreview

'"Print the form
PrintForml.Print ()
End Sub

Private Sub ExitButton Click(ByVal sender As System.Object, ByV
al e As System.EventArgs) Handles ExitButton.Click
'Exit the application by closing it
Me.Close ()
End Sub

End Class



